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Chapter One
WELCOME TO SYSTEM 6

One Small Step...

Apple 1IGS System Software 6.0 is a giant leap forward for the Apple I, the computer which
launched the personal computer revolution. In its current incarnation as the Apple IIGS, the
Apple I remembers the past with complete compatibility with older software, while looking into
the future with a Macintosh-style graphic user interface and toolbox. Now with System 6, the
IGS gains even more speed, power, and compatibility. And the best part is that System 6 works
on the computer you own now!

You've probably heard a lot about System 6, thanks to Apple. Developers saw a very rough
version of System 6 at the A2-Central Summer Conference in July, 1991 and were mailed a pre-
release version on CD-ROM later that year. Unexpectedly, these developers were actually
encouraged to discuss System 6 on electronic information services and in other media. Apple
software engineers, too, were permitted to talk about System 6 publicly, leading to an
unprecedented amount of pre-release discussion.

We're pleased to tell you that most of what you've heard is true. System 6 will catapult your
lIGS into the nineties and beyond. We think you'll enjoy the trip.

What’s New

Here are the most important new features of System Software 6.0.

* StyleWriter printer support. Now you can use Apple’s low-cost inkjet printer with any
Apple HIGS Desktop program. System 6 also has more large fonts to take advantage of
the capabilities of this and other high-resolution printers.

* Macintosh, Apple DOS 3.3, and Apple Pascal disk support. Now your IIGS can read
Macintosh, DOS, and Pascal disks as easily as standard ProDOS disks. System 6 can
format and write to Macintosh disks as well (DOS and Pascal disks can only be read).
The 11GS still can’t run Macintosh software, but exchanging data is easier than ever,

* A completely redesigned Finder. Faster, friendlier, and more powerful than ever
before, with advanced features like tunneling and Finder extensions.




s All-new desk accessorics featuring a Calculator and Find File. Even the Control Panel
has been revamped-—eceach Control Panel now appears in its own independent
window, just like on Macintosh System 7.

* A general rounding-off of rough edges. The Finder can be set to avoid grinding your
5.25” drives. When the computer asks you to insert a disk it needs, you no longer have
to hit Return—the computer detects it automatically. The screen no longer switches to
text mode and back to graphics when launching some Desktop programs.

* New music tools and applications to allow new programs to sound even better. You
may have heard of SynthLab, Apple’s prototype music program—it’s included.

* Media-control toolset and desk accessorics to allow even easier integration of video
with your multimedia presentations.

* Special Aids (Video Keyboard, CloseView, and Easy Access) for physically
handicapped users.

* More tools for programmers to write great programs. Like drivers for Apple flat-bed
scanners and SCSI tape drives. You may never use these tools directly, but they’ll make
writing quality 11GS software even casier. And eventually more and more 11GS programs
will take advantage of special System 6 features.

s Simpler and faster hard drive installation. The new Installer’s Easy Update option lets
you install System 6 painlessly from the self-booting Install disk. If you need to
customize your installation, of course, you can do that too!

* ProDOS 8 Enhancements. ProDOS 8 now remaps other hard drive partitions to unused
slots, starting with Slot 1. At last—if you have a hard drive attached to an Apple SCSI
card, you can now access all your partitions from ProDOS!

There’s much more, of course. System 6 is a project that took a team of skilled programmers
over a year to complete. To learn more about the new features of System 6, look for the sections
throughout this book labeled with a ®.

System Requirements

System 6 requires a minimum of 1.25 megabytes of RAM with ROM 01 (the standard
configuration plus a 1 megabyte expansion card), or 1.125 megabytes of RAM on ROM 03 (the
standard configuration), and a single 3.5” drive. A hard disk drive is highly recommended (hard
drive installation requires 2 megabytes of RAM). Additional memory and/or an additional 3.5”
drive are highly recommended. System 6 also supports many other peripherals, including
printers, modems, 5.25” drives, and modems.
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About This Book

Contents

We start out by telling you how to get started with System 6—by making backup copies and
installing System 6 on your hard drive, if you have one. Next, we talk about how System 6 and
the Apple IIGS Desktop work—this is must-read information if you're not familiar with using
Desktop programs. Then we talk about the Finder and System 6s desk accessories, control
panels and utilities.

Each section is divided into chapters, which are further divided into logical divisions that make
finding the material you need simple. We hope you find this book an enjoyable and useful
reference as you use System 6.

Conventions

We've made this book easier to navigate by differentiating the chapter titles and subheadings in
different sizes and styles of Optima, an extremely casy-to-read typeface. We also draw your
attention to the types of information below with special formatting:

= Note!
These paragraphs contain essential information that requires your complete attention.
Understanding this information is very important to effective use of System 6.

@ Warning!
These paragraphs alert you that you might damage equipment or lose data if you don’t follow
the instructions carefully. This icon is a sort of emphatic Note! icon.

ws  Shortcut
These paragraphs alert you to time-saving technigues that can make your life easier.

A By The Way...
These paragraphs contain interesting but nonessential information related to the topic at hand.

® New & Improved
These paragraphs tell you how System 6 differs from previous system versions, pointing out
completely new features or familiar features that work differently in System 6.

What Should I Read?

If you're new to the 11GS or have been using the 11GS only to run programs like AppleWorks and
have little experience with the 1IGS way of doing things, we suggest starting reading this entire
book. If you're a seasoned IIGS user updating from System 5, you'll want to skim the Desktop
and Finder chapters (looking for ® New & Improved scctions and similar information) and pay
close attention to the Utilities chapter.

Welcome To System 6 3




About The Disks

The Apple Disks
Apple ships [IGS System Software 6.0 on six 3.5” disks. Thesc disks are:

System Disk—System 6 on a bootable stand-alone 3.5” disk
System Tools 1 & 2—Additional system elements for installation
Fonts—Additional fonts for users with high-resolution printers
Install—A bootable 3.5” disk for performing System 6 installation
SynthLab—The SynthLab application and sample music files

e & & e o

The Bonus Pack Disks

If you bought the System 6 Bonus Pack, you got six additional 3.5” disks:

* Bonus Stuff—Desk accessories, icons, clip art, Shrinklt, FlashBoot, and HyperSound

* Bonus Fonts 1 & 2—More unique and interesting fonts to supplement Apple’s selection
e Bonus Sounds 1T & 2—Sounds to spice up your lIGS desktop and hypermedia stacks

» ZZCopy—Utility for backing up 3.5” disks, plus shareware programs
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Chapter Two

GETTING STARTED

Read This Before Doing Anything!

If You Don’t Have A Hard Drive

If you don't have a hard drive, we heartily suggest making the investment. While System 6 will
run fine on 3.5-only systems, you may end up with longer waits and, if you have only a single
3.5 drive, more disk swapping than with previous versions of the [IGS System Software. A good,
fast hard drive is the single most significant improvement you can make to your computer
because it allows you to store not only your System Software but all your programs and data on
a single high-speed storage device. Don't take our word for it—ask anyone who already uses a
hard drive on their IGS. If you don't have the funds for a hard drive, an additional 3.5 drive or
more memory can provide many of the same benefits at a lower cost.

If you decide not to get a hard drive, you won't really “install” System 6. You'll just start up the
computer from the System 6 System Disk, just as you started up the System 5 (or earlier) System
Disk when you wanted to use that System version. You may find that the additional features of
System 6 are worth the occasional disk swap and choose to run under System 6 all the time, or
you may decide to use System 6 only when you need its special features and start up directly
into other programs via whatever System Software they came with. It's your choice.

If you have more than two megabytes of memory installed in your Apple 11GS, you may want to
reserve some of your memory for use as a RAM Disk and install System 6 on the RAM Disk. See
the FlashBoot manual for more information on using your 11GS RAM Disk and our exclusive
FlashBoot utility.

= Note!
Be sure to back up your System 6 disks before using them. See the section after the next one
for instructions on using the ZZCopy program.

The System Disk included with the System 6 package is a minimum configuration. It's adequate
for running most programs, but a few programs may require additional tools, fonts, or drivers to
be installed. The System Disk has a little free space on it, so you can make another backup of
the original System Disk, install the additional software on it, and use that as a special-purpose
System 6 startup disk for a particular program. For more details on the Installer, see the hard
drive installation section in this chapter.




If You Do Have A Hard Drive

We suggest resisting the temptation to install everything at once. That makes getting used to
System 6 more difficult than it needs to be, and it also makes diagnosing your problems harder
too. First install the System 6 “Easy Update” (hard drive installation instructions will follow in a
moment). Then browse through this book and Icarn about System 6’s new features. Skip over
any sections that talk about software you haven’t installed yet. Then install any additional
System 6 features you want, and get used to them, too. Finally, install the System 6 Bonus Pack
if you purchased it, and learn to use its features.

Remember, even seasoned uscrs can feel overwhelmed by adding half a dozen disks” worth of
new software to their computing environment.

== Note!
Before doing anything, read this entire chapter and make sure you understand how to install
System 6. If you don't, call our Technical Support department for clarification.

Making Backup Copies

Before beginning installation of System 6, you should make a sct of backup disks. (The same is
true of any program you get. Back up the originals, put the originals in a safe place, and usc
only the backups.) Yeah, we know some of you won’t make the backups because there are 50
many disks—that’s not our fault, though. MAKE THE BACKUPS!

A By The Way...
If you have to calt our technical support line to get a new copy of a disk you somehow messed
up, the first thing our tech guys are going to ask is, “What happened to your backups?” and
you’re going to feel really, really stupid. Of course, if the disk was bad right out of the box we’ll

replace it promptly and we won't Jaugh at you at all.

If you have a favorite utility you use for making backup copies of disks (Copy Il Plus, for
example), feel free to use it to back up your disks and skip this section. The FastCopy program
that comes with AppleWorks is quite simple to use and will do an admirable job of backing up
the System 6 disks. Use whatever you’re most familiar with.

If you bought the System 6 Bonus Pack, we've also included a utility called ZZCopy which can
be used to make backup copies of the System 6 disks. To use this program to make backup
copies of your disks, follow these steps:

1. Make sure the IIGS Startup Slot is sct to “Slot 57 using the Control Panel. (If you’re not
familiar with the Control Panel, consult your Apple 11GS Owner’s Manual.)

2. Put the ZZCopy disk in your first (or only) 3.5” drive and start up the computer (turn on

the computer if it's off, or hold down & and Control while pressing Reset if the
computer is already on).
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3. When ZZCopy is finished loading, you'll see a picture of the designers of ZZCopy and
your HIGS will say “Welcome.” Then the ZZ Copy disk will be ejected and message
“Insert Source” will appear.

4. Grab one of your original System 6 disks (it doesn’t matter which one you start with as
long as you copy them all) and open the write-protect slide, then insert it in your first
3.5" drive. ZZCopy will read the disk, then display the message “Insert Target.”

5. Insert a blank or reusable disk. (If you have two disk drives, put it in your second
drive.) This disk will be completely erased, and ZZCopy won't ask you if it's OK to
erase it first, so make sure there’s nothing important on it! ZZCopy will write a copy of
the original disk onto your backup, then display the message “Insert Source.”

6. Repeat steps 4 and 5 until you've backed up all the System 6 (and Bonus Pack) disks,
including the ZZCopy disk.

7. Don’t forget to set the Startup Slot back to your usual setting—normally “Scan”—using
the Control Panel.

if, during the copy operation, ZZCopy detects an error, the IlGS will say “Alert!” and display an
error message on the screen. If the error is on your target disk (the one you're copying onto),
throw out the bad disk and go back to Step 4 to reload the original disk. Use a different target
disk this time. If there’s an error on the source disk (an original), call Quality Computers and
we’ll send you a new copy of that disk.

Installing System 6 On Your Hard Drive

Keeping Existing System Software

If your hard drive already has System 5 (or another older system) installed, you may want to
keep it around until you’re used to System 6 and are sure it's compatible with all the programs
you're already using. (Plus you’ll be able to move your favorite desk accessories, fonts, and
other system enhancements from the old System to the new System and back.)

The easiest way to keep System 5 on your hard drive while installing System 6 on the same
drive is to rename the System and Icons folder. You don't have to do this, and we definitely
suggest you don't do it just yet—read this whole section before doing anything—and make sure
you’ve made backup copies of your System 6 disks first.

Here's how (we'll assume you're already familiar with using your hard drive, at least a little):
» Start up your system as you normally do, booting from the hard drive.

° If any windows are open, close them all by pulling down the “File” menu and
selecting “Close All.”

Getting Started 7




* Double-click your startup disk’s icon (in the upper right corner of the screen) to open
its window,

* Make sure there's at least 1 megabyte (MB) free by looking at the information bar in
the window you just opened. If there’s not at least that much disk space free, you
should free up some space (by deleting unused files or moving information to other
hard drives or disks) before trying to install System 6.

* Scroll the window until you find the System folder, a folder with a rainbow apple on it.

* Click the System folder once, then type “System5” (without the quotes) on the
keyboard, and press Return.

* Find the Icons folder in the window. Click it once and type “lcons5” (again omitting
the quotes) and press Return.,

@ Warning!
Once you've performed this procedure, you won’t be able to start up from your hard drive until
you've installed new system software on it. You should install System 6 immediately after
performing this procedurs.

Preparing For Installation

Make sure your 11GS’s Startup Slot is set to Slot 5, so that the computer starts up from the 3.5”
floppy drive. (You can do this using the IGS Control Panel. If you're not familiar with the
Control Panel, see your Apple HGS Owner’s Manual.)

System 6 includes a self-booting installation disk that includes the driver for the Apple SCSI
Card. This means that System 6 will recognize most hard drives automatically. If you have a
SCSI-compatible hard drive connected to your computer via an Apple SCSI Card, start up your
system from the Install disk and proceed directly to the installation instructions.

If you have an Applied Engineering Vulcan hard drive, you must boot from a disk containing the
Vulcan driver before you can run the installer. If you don’t, the Installer will think you have
ejected your hard drive during the installation and ask you to “Insert the disk AE1.”

There’s not enough room on the Install disk for the Vulcan driver. The System Disk does have
some free space on it, so we suggest installing the Vulcan driver on the System Disk (placing it
in the Drivers folder, inside the System folder, as described in the Vulcan manual), starting up
from that disk, inserting the Install disk after the Finder appears, and double-clicking the Installer
to start it up. If you have a single 3.5 drive, you'll be in for some additional disk swapping, but
installation isn’t something you do cveryday, anyway.

If you have a RamFAST/SCSI hard drive controller, you don’t need its driver installed to perform

System 6 installation. The Install disk will work fine for installing System 6 on a hard drive
connected to a RamFAST/SCSI card; just start up from the Install disk and proceed.
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Easy Update

The Installer’s “Easy Update” screen (Figure 2A) is fairly straightforward. There's a message that
tells you what disk System 6 will be installed on—in our example, it says “Click ‘Easy Update’
to install Apple 1IGS System Software on the disk ‘Q1”.” If the name of the disk is wrong, use the
mouse to move the arrow to the “Change Disk” button, like it is in our example. Click the
mouse button once and wait to see what disk appears next. (It may take a second or two for the
next disk’s name to appear). If that's not the right disk, click the mouse button again and wait for
the next disk name to appear—keep doing that until the name of the disk you want to install
System 6 on appears on the screen,

A By The Way...
If you have a Q Drive, you probably want to install System 6 on the disk named “Q1.” If you
have a Vulcan, you'll probably want to install to “AE1.” If you have some other hard drive, the
name will probably be different, but you should recognize it when it appears. In any case, you
want to install System 6 on the first partition on your hard drive.

= Note!
If the correct disk name never appears, contact Technical Support for heip. If, on the other
hand, it appears briefly and then disappears, you're clicking the “Change Disk” button too
quickly. Remember to wait until the new disk name appears on the screen before clicking
“Change Disk” again.

ile £dit Help

Click *"tosy Update® to install Apple 116S E
§guslt'e| Software version 6.0 on the disk

FosylUpdate |

Click “Change Disk” if “Easy Update* is :
disubled. *Easy Update” can’t modify the Change Disk

current startup disk, the Installer ( Eject ) [
disks, or non-ProD0S disks. g
|

Figure 2A—System 6 Installer: Easy Update Screen
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Once you've selected the disk you want to install System 6 on, move the arrow to the “Easy
Update” button and click the mouse button. Installation will begin. You'll be prompted to
switch disks a few times—just remove the disk the computer is finished with, and insert the next
disk. The HIGS will automatically detect that you've inserted the new disk and continue—there’s
no need to press Return or click the on-screen “Ok” button.

= Note!
If the Easy Update button is “dimmed” (i.e., the words “Easy Update” are displayed in gray
instead of in black), you're probably trying to install System 6 on the disk you started up from.
Start up from the Installer disk (or from the System disk containing the Vulcan driver, if you
have a Vulcan hard drive) and try again.

After installation is complete, set the Startup Slot back to its usual value (“Scan” or “Slot 7" in
most systems) using the Control Panel. Hold down & and Contro! while you press and release
Reset to restart the computer and enter the world of System 6.

If you have an AE Vulcan hard drive, an AE High Density 3.5” drive, a RamFAST/SCSI card, or
any other third-party device requiring a driver {such as Hewlett-Packard printers) install their
drivers according to the directions that came with the device. (If the driver software is old, it
might be a good idea to contact the manufacturer to make sure the driver is compatible with
System 6 before installing it.)

You can install additional system software features right away, as well, but we suggest you get
used to System 6’s basic features before you add any other features, especially if you're fairly
new to the 1IGS. Read through this manual (particularly the chapter on the Finder) and then,
when you're comfortable with System 6, install additional features like Macintosh disk
compatibility, networking, sounds, and drivers for your other peripherals like CD-ROM.

Installing Additional Features

As we mentioned in the last section, the Installer can install many System 6 updates, not just the
“Easy Update.” Once you're familiar with the basic System 6 features, you can install additional
features as easily as you installed the original system software.

Remember, each additional feature you install needs more memory and more disk space. If you
plan to use all of System 6’s features, we suggest a minimum of 2 megabytes of RAM—and the
more, the better.

To install additional System 6 features, get into the Installer as described in the section above
and choose a disk using the “Change Disk” button. Then click the “Customize” button. A list of
available system updates (Figure 2B) will appear. Use the scroll bar to the right of the list to look
at the entire list of updates; select the updates you want to install from the list.

To select more than one update to be installed at once, hold down the & key while selecting the

second and subsequent updates. (The same maneuver can also be used to unselect an update
that you selected accidentally.)
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Figure 2B—System 6 Instalier: Custom Installation

System 6: Hard Disk or FDHD: Installs the “Easy Update,” plus some additional system
software such as the Calculator and Find File NDAs, the HFS FST (for accessing
Macintosh disks), the Sounds control panel, and the Special Aids software. This update
requires at least a megabyte of disk space (and thus, you must install it on a hard drive
or high-density 3.5” disk). We suggest that you install the “Easy Update” instead, and
then install the other items that interest you, because the Special Aids are incompatible
with several popular programs including AppleWorks GS.

System 6: No “Start” Update: Installs the same software as above, but doesn’t update
your existing Start application. (Use this update to completely replace older System
Software with System 6 while keeping your current program selector, such as ProSel or
Wings.)

System 6: On 800K Disk: Installs the bare minimum System Software on a blank 3.5”
disk or RAM Disk in less than 800K.

Application: Installs the named application—Advanced Disk Utilities (useful for
partitioning and formatting a hard drive), Apple Bow! (a bowling game), Archiver (a
backup utility for 3.5” and hard drive users), SynthLab (a new music program), or
Teach (a simple word processor). We suggest Archiver and Teach as definite must-
install programs, and SynthLab is great if you're at all interested in music. Having the
Advanced Disk Utilities on your hard drive doesn’t seem that useful to us—if you
format or partition the drive, everything, including ADU, will be erased.

Control Panel: Sound: Installs the Sound control panel and a few sample sounds. This
is a definite must-install for most hard drive users—it’s useful, and a lot of fun, too.

Getting Started
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Once you've selected the update(s) you want to install, click the “Install” button to begin
installation. The Installer will prompt you to swap disks when needed; just eject the old disk and
insert the correct disk. The Installer will automatically detect the new disk and continue the

Desk Acc: Installs the named desk accessory, the Calculator or Find File. Find File is a
must-have for hard drive users; the Calculator is also useful, but there’s a better one in
the System 6 Bonus Pack.

Drive and Driver: Installs drivers for the named devices. The “Easy Update”
automatically installs Apple Disk 5.25”, Apple Disk 3.5, and SCS! Hard Disk drivers if
you have those devices attached to your computer. If you have other devices, install
them here.

File System: Installs File System Translators (FSTs) for Macintosh (HFS) disks, Apple
DOS 3.3 disks, and Apple Pascal disks. The HFS FST is highly recommended; it allows
you to read, format, and write Macintosh disks in your Apple IIGS drives, and
additionally lets you access Macintosh hard drives attached to your computer. The
DOS 3.3 and Pascal FSTs allow you to read (not write) 5.25” disks in these older disk
formats.

Fonts: The “Easy Update” option installs “Standard” fonts if there’s enough room or
“Minimum” fonts otherwise. We recommend that hard drive users install “All” fonts.

Media Control: These install drivers for various types of video and audio disc players,
along with the Media Control Toolkit, which allows you to control these devices as
part of multimedia presentations. Media drivers should be installed if you have a MIDI
synthesizer interface; VideoMix should be installed if you have a Video Overlay Card.

Network: Network updates should be installed if you're attached to an AppleTalk
network and want to share files or print to a shared printer.

Printer: Install the correct update(s) for your printer(s), including network (marked as
“ATalk”) printers such as the LaserWriter, ImageWriter, and ImageWriter LQ.

Special Aids: These are tools for helping physically handicapped users use the IIGS.
CloseView magnifies the screen; Easy Access provides “Sticky Keys” and “Keyboard
Mouse” features; Video Keyboard provides an on-screen keyboard that users can click
instead of typing on the keyboard. We do not recommend Special Aids for most users,
because some are incompatible with popular programs such as AppleWorks GS.

installation,

When the installation is complete, change the Startup Slot (in the Control Panel) back to its

usual setting—usually “Scan”—and restart the system to begin using the updates.

12
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Summing up, then, we recommend the following updates for most hard drive users:

Easy Update to start with

Archiver, Teach, and SynthLab applications

The Sound control panel

The Find File and Calculator desk accessories

Drivers for any disk drives you have attached to your 11GS
All file System Translators (what the heck, you might as well)
All fonts

Driver(s) for your printer(s)

¢ & © & © © ¢ o
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Warning!

When installing Apple system software, always use the Installer. The Installer will always make
sure you have all the files you need for a particular installation. If you attempt to install system
software manually, using the Finder or a similar tool, it's all too sasy to miss files, or fo not
update files that need updating. This can cause unexplained system problems.

Installing The Bonus Pack

We recommend that you install the Bonus Pack only after you're thoroughly familiar with the
features of System 6. Installing before you’ve read this manual will only confuse you, because
some of the things we discuss elsewhere in this book apply only to standard Apple-issue System
6. The Bonus Pack adds a number of new features to System 6, but it is not provided by Apple.

The Bonus Pack is installed via a program called Shrinkit. Shrinklt allowed us to pack lots of
extras into the Bonus Pack—much more “stuff” than would normally fit onto a disk—because it
can actually make files smaller. Shrinklt isn't quite as easy to use as the Installer, though,
because it's a general-purpose program. We assume some familiarity with using Desktop
programs (which you'll gain if you read this manual, or which you may already have).

To get into Shrinklt, start up your system from your hard drive as you normally do. (If you don’t
usually start up into the Finder, get to the Finder by quitting your startup application or by
launching the Finder from your program selector.) Insert the Bonus Stuff disk and double-click
its icon. Then click the GSHK icon—that’s the GS Shrinklt application. Now you're ready to
install part or all of the Bonus Pack.

We'll run you through installation of the Bonus Desk Accessories; they're typical:
1. Choose “Open” on Shrinklt's File menu, insert the Bonus Stuff disk, and double-click
the file “Desk.Accs.SHK” to open it. The contents of the file will appear in Shrinklt's
archive window (Figure 2C).

2. Pull down the Edit menu and choose “Select All.” The files in the list will turn green.

3. Click the “Extract” button. A Standard Save dialog will appear. Click the “Volumes”
button, than double-click the disk you want to install on (your startup disk).

Getting Started 13




Once you've done that, you'll have a pretty good handle on how to install most of the other

When the list of files and folders on your startup disk appears, find the System folder
and double-click it to open it.

Find the Desk.Accs folder on that list, and double-click it to open it. The name at the
top of the window should now read “Desk.Accs” (Figure 2D).

_ Click the “Extract” button and stand back while Shrinklt places all the Bonus Desk

Accessories in the Desk.Accs folder on your startup disk.

. When that’s finished, select “Close” from the File menu.
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Figure 26—Shrinklt: Archive Window (Desk.Accs.SHK Opened)

Bonus Pack items. Here are some pointers:

« Sounds: Before you install the Bonus Sounds, make sure you've already installed the

14

Sound control panel (see previous section). There are two disks worth of sounds. You'll
insert the Bonus Sounds 1 disk first and open the “Sounds.1.SHK" file. Then choose
“Select All” from the Edit menu, and click “Extract.” Follow Steps 3 and 4 above. In
Step 5, open the Sounds folder (not Desk.Accs), then click Extract and stand back.
Now close the Sounds.1.SHK archive (“Close” from the File menu). Follow the same
procedure with the “Bonus Sounds 2” disk and the “Sounds.2.SHK” file. You won't
need to tell Shrinklt to move to the Sounds folder when you're unpacking the second
batch of sounds—it will remember that folder from the first extraction.

Chapter Two



* Fonts: There are also two disks of Bonus Fonts. They go in the Fonts folder inside the
System folder on your startup disk. Follow the instructions for “Sounds” above, except
remember that wherever it says “Sounds” you should think “Fonts.”

e Finder Extensions: The Bonus Finder Extensions are on the Bonus Stuff disk, in a file
called “Finder.Ext.SHK.” They go in the System.Setup folder inside the System folder
on your startup disk. Follow the instructions above for installing the Desk Accessories,
except open “Finder.Ext.SHK” in Step 1 and open the System.Setup folder in Step 5.

e Icons: The Bonus lcons are also on the Bonus Stuff disk, in a file called “lcons.SHK.”
Open this file as above. However, in Step 4, open the Icons folder instead of the
System folder. Skip step 5 entirely—the Bonus Icons go directly in the Icons folder on
your startup drive.

e Clip Art: The Bonus Clip Art is on the Bonus Stuff disk in a file called “Clip.Art.SHK.”
Open this file using Steps 1 through 3 above, using the appropriate disk and file. Skip
Steps 4 & 5—unpack the clip art to your startup disk by clicking “Extract” in the
Standard Save dialog. Shrinkit will automatically create a folder called Clip.Art and
place all your Bonus Clip Art files in this folder.

There, you're done (whew)! Choose “Quit” from Shrinklt’s File menu to return to the Finder,
then restart the computer to take advantage of the new Bonus Pack features!
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Figure 2B—Shrinkit: Extracting Bonus Desk Accessories to Desk.Accs Folder
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= Note!
If you don’t want to install all of the Bonus Desk Accessories (or Sounds, or whatever), check
the disk for a Shrinklt instruction file. Among other things, this will tell you how to extract only
some of the files from a Shrinkit archive. (Basically, you click only the file you want to install
instead of choosing “Select All.”) Plus you'll learn how to use one of the most useful [I1GS
programs around! Alternately, you could unpack the Bonus files to another folder, and move
the ones you want to use into the appropriate folder inside your System folder.

¥elcome to the les
System 6.0

Figure 2E—System 6 “Splash Screen”

Starting Up System 6

You'll start up System 6 the same as any other disk—by turning the computer on with the
appropriate disk in a drive (or with your hard drive ready to go), or by holding down & and
Control while pressing and releasing the Reset key. And, on the surface, System 6 looks a lot
like System 5, which you may already be familiar with.

The first thing you see is the System 6 “splash screen” (Figure 2E). This screen tells you that

you're using System 6 and gives you some indication of how much longer the system will take
to start up, via the red thermometer bar, which fills as System 6 loads.

By The Way...

started up your computer from that disk. It's only an estimate. Your startup time may change

A
J}j"_) Z The thermometer fills at a rate that reflects how long it took to load System 6 the last time you
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when you add or remove items from the System folder.
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As System 6 loads, it displays small pictures—icons—across the bottom of the screen. These
small pictures tell you which startup items are loading—for example, the “boot” icon tells you
that the SetStart control panel has just loaded.

A By The Way...
You can keep your startup items (called “inits” in 11GS parlance) and desk accessories from
loading by holding down the Shift key as you start up the computer. When the message “No
Inits/DAs” appears under the “Welcome to the 11GS” banner, you can release the Shift key.

When the thermometer fills and the System 6 splash screen disappears, a program called the
Finder usually appears. (You can change your startup program with the SetStart control panel).
The Finder is “home base” for 11GS users—you’ll use the Finder to back up and maintain your
disks, as a “launch pad” for running your programs. If you’re unfamiliar with the Finder (or wish
to learn more), be sure to read Chapter 5.

Switching Between System 5 & System 6

Once System 6 has been installed, you can switch back to System 5 without removing System 6
by doing the following things (assuming you took our suggestion about renaming your existing
Icons and System folders): ‘

Open your startup drive’s icon.

Click the System folder, type “Systemé” and press Return.

Click the Icons folder, type “Icons6” and press Return.

Click the System5 folder, type “System” and press Return.

Click the Icons5 folder, type “Icons” and press Return.

Restart your 1IGS by holding down the & and Control keys while pressing and releasing
the Reset key.

You can switch back to System 6 from System 5 (assuming you've followed the above
procedure) by performing these steps:

Open your startup drive’s icon.

Click the System folder, type “System5” and press Return.

Click the Icons folder, type “Icons5” and press Return.

Click the Systemé folder, type “System” and press Return.

Click the Iconsé folder, type “Icons” and press Return.

Restart your IIGS by holding down the & and Control keys while pressing and releasing
the Reset key.

® © & o o o
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Don’t Forget!

Check the System 6 disks for “Read Mc” files that contain last-minute instructions that didn't

make it in time for the manual. The “Shortcuts” file on the System Tools 2 disk is full of
interesting information, some of which you won’t find anywhere in this book!

And... remember to enjoy System 6!
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Chapter Three
WELCOME TO THE DESKTOP

The Desktop Metaphor

In the early eighties, some software engineers at Xerox's Palo Alto Rescarch Center (PARC)
began working on more effective ways to allow people to communicate with computers. Their
studies found that most people process pictures faster than words, and that they prefer to
manipulate their work as directly as possible. Based on these results, they began designing a
brand new user interface that was intuitive, pictorial, and direct. (The user interface is how you,
the user, communicate with your computer. Early user interfaces were based on typing
commands. Today’s Graphic User Interfaces, also called GUIs, owe a lot to Xerox’s research.)

Steve Jobs, co-founder of Apple and father of the Macintosh, saw an early version of the Xerox
team’s user interface on a visit to PARC. He decided that the basic elements of the Xerox user
interface (an on-screen pointer linked to a pointing device called a mouse, along with movable
windows, small pictures called icons, and a compact pull-down menu system) would be a part
of Apple’s next computer—the Lisa,

The Lisa, which cost $10,000, was a less-than-stunning commercial success, so Apple soon
dumped it and introduced a similar but less expensive computer—the Macintosh. The rest of
that story is, of course, history—and the technology also made its way to the Apple Il line. The
Apple lIGS is the first Apple I to feature built-in support for the Apple Desktop user interface,

So What’s The Metaphor?

For keeping cows in, of course. But seriously, a metaphor (when you're talking about
computers—forget the definition you learned in English class) is simply a computerized model
of the real world. Most people work at a desk; the desktop metaphor is a way of allowing you to
do work on the computer in a manner as close as possible to the way you work in the real
world, using simulations of familiar tools.

Of course, the simulation isn’t perfect. No one who works with a computer really thinks they’re
working on a desktop. Most people’s desks aren't the bright blue of the 11GS Desktop, for one
thing, and when writing notes on a real notepad most people don’t reach for the Edit menu to
select Cut when they make a mistake. But the Apple Desktop has been tested and refined to
such an extent over the years that the 11GS is probably as easy to use as a computer can be—at
least until the next user interface breakthrough. The Desktop’s goal is to make the computer an
extension of your mind, so you can work without thinking about how to use the computer.
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Consistency

One of the real conceptual breakthroughs of the Apple Desktop is that all Desktop programs
behave similarly. When you see the blue desktop screen appear with the menu bar at the top,
you can assume that the program does certain things in certain well-defined ways, even if
you’ve never used that particular program before. For example, if you want to stop using the
program, you'll always find the Quit command in the File pull-down menu. If you want to move
some of your data from one part of a document to another, you first select the data you want to
copy, then you use the Cut and Paste functions in the Edit menu. Always. Furthermore, you can
safely assume that 3-X activates the Cut function and G-V activates the Paste function.

We'll cover all of the above information in more depth later. For now, just remember that
consistency is an important feature of the Apple Desktop. Individual programs may extend the
desktop metaphor in ways that make sense in that program, but every true Desktop program is,
to a point, similar to every other Desktop program.

Object-Action Orientation

When you're working on something in the real world, usually you first decide what you're
going to work with, then you decide what you're going to do. For example, if you're
proofreading your latest best-seller, you'll probably notice a misspelled word before you reach
for your red pencil to correct it.

The Apple Desktop works the same way. In the Apple Desktop, you always select the thing you
want to work on (the object) before telling the computer what to do with it (the action). For
example, if you want to remove a 3.5” disk from the Finder Desktop, you’ll first click on the
disk, then select “Put Away” from the File menu. If you want to copy a word from a word
processing document to the clipboard, you'd first select the word (by double-clicking it), then
select “Copy” from the Edit pull-down menu. This object-action orientation is consistent in
Desktop programs, and it's designed to make using the 11GS more like the way you really work.

Contrast this with the way programs like AppleWorks work. First you have to decide you want
to delete something, then you tell it what to delete. If you change your mind about the action
you want to perform, you have to cancel the operation and choose a new one. Then you have
to re-select the object you want to work with—even if it’s the same one as before.

in the most frequently used operations, the action and the object merge. For example, double-
clicking an icon in the Finder opens it. The first click selects the object and the second click is
the action, but they're so closely linked that they’re one intuitive operation in the user’s mind.
This is the Apple Desktop at its best!

20 Chapter Three



Split Personality 11Gs

The Apple IIGS is, uniquely, designed to run both 11GS Desktop programs and older Apple II-
compatible (8-bit) programs. It's possible to run both a friendly Desktop program like the Finder
and an older program with no user interface to speak of on the same machine! The authors of
this older Apple software had to design and program their own user interfaces because Apple |l
models before the 11GS didn’t have built-in support for the Apple Desktop. The result: no two
programs ever worked the same way. (The consistency factor, remember?)

some newer programs for 8-bit computers (Apple lle and lic) do use the Apple Desktop user
interface. The designers of these programs took it upon themselves to make their programs work
like the Apple Desktop, even though it meant programming a complete user interface. Although
Publish It! 4 and ProTERM 3.0 (to name two examples) run on the 11GS as well as older Apples,
and although they work somewhat like Desktop programs, they’re not 11GS Desktop programs.

When you're using any 8-bit program on your IIGS, your GS is essentially pretending to be a
lle, and most of the special features of the 11GS are not available. You won’t have access to
System 6 features like New Desk Accessorics (NDAs), File System Translators (FSTs), and 11Gs
printer drivers because, in its lle emulation mode, the 1IGS cannot support these features. That's
not to say these look-alike programs aren’t useful—many are. Just keep in mind that most of
System 6's features work only from real Desktop programs.

A By The Way... ,
If there’s a rainbow-colored Apple at the left end of the menu bar, you're probably using a real
Desktop program. If there’s no Apple or if the Apple isn’t rainbow-colored, you're probably
using a program that only looks like a Desktop program.

A Closer Look

Let’s take a look at a screen from a I1GS Desktop program (Figure 3A). This screen happens to be
from the Finder, but other Desktop programs have a similar look and feel. (The Finder is a bit
unusual because it is specifically designed not for a particular application like word processing,
but rather as an organizational tool for your disks, documents, and programs. Still, it's a program
you'll be using frequently, so it’s a good place to start.)

You'll first notice the menu bar at the top of the screen. The menu bar is the Desktop’s “main
menu.” In non-Desktop programs, you're usually presented with a main menu containing
general things you can do, which branches out into submenus. For example, in AppleWorks,
when you select “Add Files To Desktop” from the main menu, you're presented with a submenu
that allows you to create a new file or load an existing file to the Desktop.

Welcome To The Desktop 21




% File Edit Windows View Hisk Special Caler Extras

ProD0S 20 items

ProD0S
Icons

Figure 3A—Sample Desktop Screen (from Findar)

A By The Way...
The AppleWorks desktop, in case you haven't guessed, is not at all related to the desktop
metaphor we're talking about in this book. The AppleWorks desktop is just a place to store
your files while you're working on them. The Apple Desktop is a much more general concept—
it's a way of interacting with your computer.

The Desktop’s menu bar is its main menu—it lists all the kinds of things you can do in the
program you’re using. In the Finder, the things you can do are divided into the categories of
File, Edit, Windows, View, Disk, Special, and Color. The rainbow-colored & symbol to the left
of the File is also a menu. We'll explain how to use the menus and the options in them a little
later; for now, it's enough to realize that the menus are there.

The menu bar is almost always visible in a Desktop program. That's one of the basic ideas of the
Desktop—to make it clear at all times what you can do next. The menu bar takes up very little
space on the screen when you're not using it, but you can glance at it (or even browse through
it) at any time to remind yourself what options are available.

Another fundamental Desktop element is the window. A sample Finder window occupies most
of the middle of the screen. The Finder uses windows to represent the contents of a disk. Like
most Desktop windows , the Finder’'s windows can be moved, resized, opened, closed, and
scrolled. You can also open more than one window. (We'll get into window manipulation
shortly.) What you see in a window is called, naturally, a view.
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Icons are yet another Desktop element. Icons are small pictures representing documents,
programs, and other things. On the sample desktop, you can see icons for two hard drive
partitions (named Q1 and Q2), a RAM Disk (named RAMS5), a 3.5” disk {System.Disk), and an
AppleShare network volume (DATA.SERVER). There’s also a Trash can, which is used for
removing things from the Finder desktop. Additionally, the Q1 window contains even more
icons, representing documents and programs on the hard drive.

Finally, find the small arrow in the lower left hand corner of the screen. This is the pointer {(or
cursor). When you move the mouse, this small arrow moves correspondingly on the screen. You
use the pointer to select icons, manipulate windows, and choose items from pull-down menus.
In fact, our very next chapter is all about using the mouse—so stay tuned!

A By The Way...
The elements of the Desktop (windows, icons, menus, and pointer) happen to form an
acronym—WIMP. The term was originally coined by expert computer users who actually
resented the simplicity of graphic user interfaces like the Apple Desktop. These folks were used
to typing commands—and they liked it! These days, the term WIMP is used in a merely
descriptive fashion to refer to programs or computers that use a graphic user interface.
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Chapter Four

WORKING WITH THE MOUSE

Mouse Basics

This chapter is for 11GS users who have limited experience with the 11GS mouse. Although such a
chapter may seem unnecessary—most everyone has used a mouse at one time or another—this
chapter also ensures we're all talking about the same thing when we talk about mouse actions.

The mouse is a simple, elegant device for moving the pointer around on the lIGS screen. On the
bottom of the mouse is a small rubber ball, which rolls as you move the mouse around your
desktop. Sensors inside the mouse track the rotation of the ball, and, like magic, the on-screen
pointer follows your hand movement.

The mouse only detects movement when it is on a smooth, flat surface. If you run out of desk
space before you reach the spot you're aiming for on the screen, you can just pick up the mouse
and move it back. Since the ball isn’t touching the desk, the mouse doesn’t register the
movement, and you now have more room to move in the direction you want to go.
(Experienced mousers pick up the front end of the mouse just enough to move it without the
balf touching the desk.)

The mouse also has a long tail-like cord connecting it to the computer, and a button on the top.
(If the cord is the mouse’s tail, the button is positioned atop, well, its hind end.) This button is
used to select documents, icons, and menus. You may have seen mice on other computers with
two or three buttons—but you do can everything with a single button on the Apple Desktop.

If you're just getting started with the mouse, you may want to start up the System Disk to get to
the Finder and follow along.

Pointing

The simplest mouse action is pointing. To point to something on the screen, just move the
pointer to it. Position the pointer on top of the object you wish to point to—not above it, but
literally on top of it (Figure 4A), as if you were looking down on the desktop from above and the
pointer was on top of the object. (In Figure 4A, we're pointing to the System Disk. Look closely
at the System Disk icon to find the pointer.)
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When pointing to extremely small objects, like the small box in the upper left hand corner of a
window, it's useful to know that the arrow’s “hot spot” is at its tip. If the tip of the arrow is
inside the box, you're pointing to it. If the tip is out of the box, you're not pointing to it—even if
some other part of the pointer is in the box. So when we say to point to an object, we mean to
put the tip of the arrow on it.

By itself, pointing isn’t too useful—it merely tells the computer what object you want to work
with. To actually start working with an object, you nced another mouse action—clicking.

Clicking

Clicking is simple—a quick press and release of the mouse button. Clicking does different things
depending on what program you're in and where you click. In the Finder, clicking an icon turns
it black (we call that “highlighting” or “selecting” the icon). Clicking various parts of windows
also has interesting results. Clicking on text in a document moves the insertion point to the
clicked location (don’t worry, we won't talk about the insertion point untif Chapter 5, so you
haven’t missed anything). Clicking on a button in a dialog box activates that button. And so on.

By the way, in Desktop-speak, you don’t click on an object, you just click it. (You don’t “click
the mouse on the Q1 icon,” you just “click the Q1 icon.”) This usage encourages you to think of
the mouse and the on-screen pointer as being not just linked but literally the same thing.

w File Edit Windows View Disk Speciol Color Extras
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Figure 4A—Pointing to an Icon in the Finder

26 Chapter Four




Pressing, Dragging, & Dropping

Pressing

Pressing the the mouse button and holding it down is called, logically enough, pressing. As with
clicking, you don’t speak of pressing the mouse button; you speak instead of pressing the object
you're pointing to.

Pressing a menu title in the menu bar pulls down (displays) the menu. If you're following along
in the Finder, try it with the File menu. Pressing, alone, is useful to see what’s on a menu
without actually selecting an item. Release the button to remove the menu from the screen.

Dragging

To drag an object, continue to hold down the mouse button while moving the mouse. You'll
use the drag technique with icons (try dragging the System Disk icon around) and pull-down
menus. For now it may not seem too useful to drag icons around on the Desktop, but that's how
you copy files from one disk to another (more on that later).

Sometimes you’ll be required to “drag a rectangle.” You use this technique in the Finder to
select a group of icons that are close together on the screen, and to draw boxes in paint
programs. To drag a rectangle, you press the mouse at one corner of the rectangle you want to
define (it doesn’t matter which corner you start with, though most people start with the upper
left corner out of habit) and drag it to the comer diagonally opposite the corner you started from
(the lower right corner in our example). Try dragging a rectangle around some of the icons on
the Finder screen if you're following along.

Dropping

Dropping is the action that occurs when you release the mouse button after a drag. (Sometimes
this is simply called releasing, too—you generally “release” menus.) When you're dragging an
icon, you'll probably want to drop it eventually. It’s natural to speak of dropping it back onto
the desktop, or into a folder, or into the trash.

Other Mouse Maneuvers

Double-Clicking

Double-clicking is two quick clicks of the mouse with very little delay between the two clicks.
The computer registers these two clicks as one event. In the Finder, double-clicking an icon
opens it (a useful shortcut for selecting Open from the File menu); in most word processors,
double-clicking a word selects that word (remember, single-clicking in a document just moves
the insertion point). Occasionally you'll even be called upon to perform triple-clicking.
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A By The Way...
You can adjust just how the computer responds to double-clicks in the General Control Panel.
If you tend to double-click very quickly, but the computer is expecting you to double-click
slowly, you may find it occasionally registering double-clicks when you don’t mean them. If
you double-click slowly, and the computer is set for fast double-clicks, the computer may
interpret your double-clicks as two separate clicks.

Shift-Clicking

Shift-clicking means you hold down the Shift key on the keyboard while clicking. This is often
used to select a group of icons, or a number of items from a list, or a series of words in a word
processor, There’s also Apple-clicking, Command-clicking (the same as an Apple-click—that
weird propeller symbol is Apple-speak for “command”), Option-clicking, and Control-clicking;
different programs define these in different ways.

Cursors

The 1IGS uses several different cursors to give you clues about what various mouse actions will
do in a particular program. A cursor is just a more generic word for the on-screen pointer you're
already familiar with—the arrow is just one cursor, though it's probably the most common one.
The cursor changes when you move it from one type of area into another on the screen—for
example, from an arrow 1o an l-beam when you move it into a text area and back to an arrow
when you move it out of the text area. Visual feedback like this always lets you know what will
happen when you click (or drag, or double-click, or...) and lets you know instantly when a
program expects a certain kind of action.

The Arrow

k The Arrow cursor appears when you're selecting items from a menu, when you can click on
buttons in dialogs, and in places like the Finder where you can select and double-click icons.
(In some drawing programs, you can select an object in your drawing with an arrow cursor.)
Single-clicking selects an object; shift-clicking is used to select more than one object; double-
clicking opens the object. In many programs (like the Finder) you can drag a rectangle around a
group of objects to select them all. The arrow’s hot spot—the point that determines where the
computer thinks you're pointing—is at its tip.

The 1-Beam

I The 1-Beam cursor appears in word processing documents and whenever the cursor is over a
part of the screen where text can be entered. Clicking the mouse positions the insertion point;
shift-clicking selects text from the insertion point to the cursor; double-clicking selects a word.
The i-beam’s hot spot is in the center of the vertical bar.
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The Plus

The big plus-sign cursor (not the puny crosshairs you frequently see in graphics programs)
appears in spreadsheets and other programs that manipulate grids with data in them. Clicking
one data element (a cell) selects that cell: shift-clicking selects from the current cell to the
cursor; double-clicking often opens a cell for editing. The hot spot is in the center of the cursor.

The Watch & The Beach Ball

The 1IGs displays the wristwatch cursor when it’s doing something that will make you wait for a
moment. It's the visual equivalent of a “Please Wait” message. The rotating beach ball cursor
means pretty much the same thing—except for the minor difference that your computer is out
having fun at the beach while it’s displayed.

The Pointing Finger

The HyperCard and HyperStudio programs use this cursor to allow the user to click on buttons
on cards. Although HyperCard and HyperStudio allow you to have icon-like pictures in a stack,
you don’t double-click them to activate them (a single click is sufficient)—therefore, an arrow
cursor is inappropriate. A few other programs may also use this cursor to indicate the single-
clicking, not double-clicking, is used for activating icons. The hot spot is at the finger's tip.

Custom Cursors

Some programs have cursors of their own other than the ones we've described here. Paint
programs, in particular, have a wealth of unique cursors which remind you which tool you're
using. If you see an unfamiliar cursor, check the program’s documentation to see what it’s for.
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Chapter Five

WORKING ON THE DESKTOP

Pull-Down Menus

Using The Menu Bar

All Desktop programs feature a menu bar. The pull-down menus, accessed by pressing the
menu titles (8, File, Edit, etc.) are used for selecting the actions you want to perform and for
selecting options that affect the operation of the program. In the old days, menus took up the
whole screen (or a good portion of it) and you chose options from menus by typing numbers
and letters or by using the arrow keys to move a cursor from one item to the next. The Desktop’s
menu bar doesn’t require any typing, and it puts all your options literaily at your fingertips.

All Desktop menus work the same way, so once you've learned how to operate the pull-down
menus in one program, you've mastered them all. We'll be using the Finder for our examples
again, just because it’s easy to get to. Boot your System Disk and follow along if you like.

& m Special Color Extras
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Figure 5A—Pull-down menu (from Finder)
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To look at a pull-down menu in a Desktop program, just press the title of the menu you want to
look at (Figure 5A). The menu will appear and its title (e.g. “Disk”) will be highlighted (white
letters on a black background). To dismiss the pull-down menu, release the mouse button. If
you just want to browse through the available pull-down menus, continue pressing as you move
the mouse left and right across the menu bar. Menus will pull down and pop up as you move
the pointer across the menu titles.

Selecting an item from the pull-down menus is just as simple. Press the menu title and continue
to hold down the mouse button as you drag downward through the items on the menu. As the
pointer moves down, the items you point at will be highlighted. Once you’ve found and
selected the menu item you want to use, just release the mouse button. The menu item will
flash to signify that your choice has been accepted, and the menu will disappear.

If you decide you don’t want to select anything from the menu after all, just move the pointer off
the menu entirely and release the mouse button. Or, to select an item from another menu,
continue pressing the mouse button and point to one of the other menu titles on the menu bar.

Dimmed Menus & ltems

Some menu titles appear dimmed. This indicates that none of the options on the menu are valid
actions in the program under the current circumstances. For example, in Figure 5A, the
Windows menu is dimmed because no windows are open. Individual items within a menu can
also be dimmed—for example, the “Eject” option in the Finder’s Disk menu will be dimmed if
the disk icon you've selected can’t be ejected (if it's a hard drive, for example):

Checked Menu Items

Some menu items have a check mark beside them. For example, the Finder’s View menu (Figure
5B) contains a checked item which indicates how the icons in the window are organized. In our
example, “by lcon” is checked. If we selected “by Name” from the menu, the window would
change to display a list of the icons organized alphabetically by name and the check mark
would move to the “by Name” selection. In this case, we can use the menu for two things—to
actually change the view of a window, and to see which view a window currently has by
Jooking for the check mark.

The check mark is used in many other programs. For example, word processors have a check
mark in their Font menu to tell you which font (type style) you're using, as well as check marks
beside each style (bold, underlined, etc.) and size (10 point, 12 point, etc.) in use.

In some cases, the check mark is used in a slightly different way—for example, in a game, there
might be a menu item called “Sound.” If this item is checked, the game makes noise; if it’s not
checked, the game is silent. Selecting the “Sound” menu item toggles the check mark—turns it
on if it's off, or off if it's on. The context in which the check mark is used will help you
determine whether it's used in this way, or in the first way of choosing one choice from a
number of possible choices.
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Figure 5B—Check marks and menu items (from Finder)
Using Long Menus
Some menus have far too many options to fit on one screen. Platinum Paint (Figure 5C) is a

good example of a program with so many features that the author was hard pressed to cram
them all on one screen.
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Figure 5—Long Pull-Down Menu (from Platinum Paint)
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When you pull down, for example, the Misc menu, a small downward-pointing arrowhead
appears at the bottom to let you know there are more items than can be displayed. Drag the
pointer to this arrowhead and the menu will begin scrolling—moving the displayed menu items
upward and revealing new items at the bottom. An up-arrowhead appears at the top of the
menu; use it to scroll in the other direction and re-display the items that scrolled off the top.

Once you've found the item you want, selecting it works the same as if the menu didn’t scroll.
Just point to the item and release the mouse button.

Ellipsis...

Menu items followed by an ellipsis (three periods) always lead to a dialog. Dialogs are used to
specify information the computer needs to complete your request. For example, if you choose to
initialize a disk in the Finder, you'll need to tell the Finder the name for your new disk, as well
as the format you want to use. A dialog appears to request this information when you select
“Initialize” from the Disk menu. (We'll be talking about dialogs shortly.)

The Standard Menus

The first three menus on the menu bar are the same in nearly all Desktop programs. These are
the ® (Apple) menu, the File menu, and the Edit menu. (The rest of the menus will be tailored to
each program’s purpose.)

The & menu usually contains an “About” item which displays information about the program
you're running (its name, its author, the version number, and so forth). In many cases the &
menu also includes an option for on-screen help or other assistance. Below these menu items (if
any), the ® menu contains your New Desk Accessories (NDAs). NDAs are available from any
Desktop programs and are like real-life desk accessories—calculators, note pads, etc. We'll be
talking more about NDAs later.

The File menu contains options for creating, opening, saving, and closing documents (to work
with a document, you open it first; when you’re done, you close it). You'll also usually find a
few other file-related options in the File menu, like “Print,” as well as the program’s Quit option,

The Edit menu contains items which allow you to change the information you’ve selected in
some way. The “Cut,” “Copy,” and “Paste” options are used to transfer information from one
document to another using a llgs feature called the clipboard. The “Cut” option deletes the
selected information from the document and places it on the clipboard. The “Copy” option
leaves the information in your document but places a copy on the clipboard. The “Paste” option
places the contents of the clipboard into the document you're working on. The clipboard can be
used not only to exchange information between documents but also between programs.

The Edit menu usually also includes an “Undo” option, which reverses the effect of the last
action you performed. (Often selecting “Undo” again after undoing an action will “re-do” that
action). There’s also usually a “Select All” option, for selecting everything in the document
you're working on, and a “Clear” option, for deleting the current selection.
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Key Equivalents

In most programs, the most frequently used menu items are also available through keys on the
keyboard. Look for menu items with the G -symbol next to them, like Eject in Figure 5A. Holding
down the & key while pressing the letter E is the same as selecting “Eject” from the Disk menu.
As you become more familiar with the operation of the programs you use the most, you'll find
yourself reaching for the key equivalents more and more—they really are time-savers, especially
in programs like word processors where it can be a hassle to continually move your hand from
the keyboard to the mouse and back.

s Shortcut :
The following key equivalents are supported by many (but not all) Desktop programs. The first
four Edit menu key equivalents are the first four keys at the left of the bottom row of letters—
Apple chose them because they weren’t as likely to be needed by programs for other functions.

File menu Edit menu

Open &-0 Undo G-Z

Close &-W, &-K Cut A-X

New Document &-N Copy a-C

Save 4-S Paste &-V

Print G-P Select All G-A

Quit &-Q Clear Delete

Additionally, virtually all Desktop programs support &-Period and/or Escape to cancel or stop

an operation in progress.
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Figure 5B—Custom Menus (Color Menu, from Finder)
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Custom Menus

Some programs include menus that are somewhat different from the normal pull-down menus,
A good example is the Color menu in the Finder (Figure 5D). Pulling it down reveals not a list of
colors, but the colors themselves in a five-by-three grid. You select a color from this menu the
same way you'd select an item from a regular menu, except you can move the pointer sideways.
Some other programs—Ilike HyperStudio—display small icons for their tools in similar menus.

Tear-off menus are gaining popularity. In some programs, like HyperCard GS, you can detach a
menu from a menu bar and leave it lying on the screen. This is especially useful with pull-down
color menus and tool menus. Once menus are torn off, they become windoids which look and
behave somewhat like regular windows except that they stay in front of any other windows on
the screen. (Don’t worry, we'll explain windows and windoids in due course.) You can then
select an item from the torn-off menu simply by clicking on it, and you can move it around the
screen wherever you want. You can dismiss the menu by clicking the windoid’s close box.

To tear off such a menu, pull it down as usual. Then drag the pointer outside the menu. An
outline of the menu will follow the pointer. Release the mouse button and the menu appears on
your screen where you dragged it. Remember, this trick doesn’t work in all programs, just the
ones which are specifically designed to support it.

w  Note!
The Finder’s Color menu does not tear off. Attempting to do so will only make you feel silly.

Hierarchical menus are used frequently on the Macintosh but are rarely seen on the IIGS. In fact,
we only know of one program that uses them, and neither the ligs nor System 6 support them
directly, so you probably won't see very many of them. But nevertheless, if you see a rightward-
pointing arrowhead to the right of a menu item, you'll know you’re about to encounter a
hierarchical menu. When you highlight that menu item, a second menu will “pop up” to the
right of the arrowhead. Slide the pointer into this submenu and select an item from there (or
move the pointer back into the pull-down menu to get rid of the pop-up menu).

Alerts & Dialogs

Using Alerts

Alert windows (or just “alerts”) appear when something unexpected has happened to find out
what you intend to do about it. Take, for example, Figure 5E, where we have foolishly told the
computer to move the program “Teach” into a folder which already contains a program by that
name. (Well, actually, we might have meant to do that. Alerts don‘t necessarily mean you've
made a mistake.) In any case, the computer doesn’t know whether or not we meant to replace
the existing “Teach” program, so it asks us to confirm our action before erasing the old file.
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